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1. Penting

Buku petunjuk elektronik ini ditujukan untuk
siapapun yang menggunakan monitor Philips.
Luangkan waktu untuk membaca panduan
pengguna sebelum menggunakan monitor.
Panduan tersebut berisi informasi dan catatan
penting tentang cara mengoperasikan monitor.

Jaminan Philips berlaku pada produk yang
penggunaannya ditangani dengan baik sesuai
dengan petunjuk pengoperasian dan atas
presentasi faktur asli atau resi yang menunjukkan
tanggal pembelian, nama dealer, nomor model,
dan nomor produksi produk.

1.1 Tindakan pencegahan dan
pemeliharaan

) Peringatan

Penggunaan kontrol, penyesuaian, maupun
prosedur selain yang dijelaskan dalam
dokumentasi ini dapat mengakibatkan sengatan
listrik, bahaya listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan
dan menggunakan monitor komputer.

Pengoperasian

* Jauhkan monitor dari sinar matahari
langsung, cahaya yang sangat terang, dan
sumber panas lainnya. Pemaparan dalam
waktu lama terhadap jenis lingkungan
tersebut dapat mengakibatkan perubahan
warna dan kerusakan pada monitor.

* Pindahkan objek apapun yang dapat jatuh
ke lubang ventilasi atau mungkin mencegah
pendinginan elektronik yang benar pada
monitor.

* Jangan halangi lubang ventilasi pada kabinet.

* Saat menetapkan posisi monitor, pastikan
konektor daya dan stopkontak mudah
dijangkau.

* Jika mematikan monitor dengan melepaskan
kabel daya atau kabel daya DC, tunggu
selama 6 detik sebelum memasang

kabel daya atau kabel daya DC untuk
pengoperasian biasa.

* Selalu gunakan kabel daya yang disetujui dan
disediakan oleh Philips. Jika kabel daya tidak
ada, hubungi pusat layanan setempat. (Lihat
Pusat Informasi Layanan Pelanggan)

* Jaga agar monitor terhindar dari getaran
kencang atau kondisi berbahaya lainnya
selama pengoperasian berlangsung.

* Jaga agar monitor tidak terjatuh atau
terbentur selama pengoperasian atau
pengiriman.

Pemeliharaan

*  Untuk melindungi monitor dari
kemungkinan kerusakan, jangan letakkan
benda berat di atas panel LCD. Saat
memindahkan monitor, pegang bingkai
untuk mengangkat, jangan angkat monitor
dengan meletakkan tangan atau jari pada
panel LCD.

* Lepas sambungan monitor jika Anda tidak
akan menggunakannya dalam waktu lama.

* Lepas sambungan monitor jika Anda
akan membersihkannya dengan kain yang
lembab. Layar dapat dibersihkan dengan
kain yang kering saat dimatikan. Namun,
jangan pernah gunakan larutan organik,
seperti alkohol atau cairan beramonia untuk
membersihkan monitor.

e Untuk menghindari risiko sengatan listrik
atau kerusakan permanen, jangan biarkan
monitor terkena debu, hujan, atau air,
maupun berada dalam lingkungan dengan
kelembaban berlebihan.

* Jika monitor basah, segera seka dengan kain
kering.

» Jika benda asing atau air masuk ke dalam
monitor, segera matikan daya dan lepas
kabel daya. Setelah itu, keluarkan benda
asing atau air tersebut, lalu bawa ke pusat
pemeliharaan.

* Jangan simpan atau gunakan monitor di
lokasi yang bersuhu panas, terkena sinar
matahari langsung, atau bersuhu sangat
dingin.

*  Untuk memelihara performa terbaik
monitor dan memperpanjang masa



pakainya, gunakan monitor di lokasi dalam
kisaran suhu dan kelembaban berikut.
. Suhu: 0-40°C 32-95°F

. Kelembaban: 20-80% RH

Informasi penting untuk Efek Terbakar/
Bayangan Gambar

* Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.
Aktifkan selalu aplikasi refresh layar berkala
Jika monitor akan menampilkan konten
statis yang tidak berubah. Tampilan gambar
diam atau gambar statis yang tidak berubah
dalam waktu lama dapat menimbulkan “efek
terbakar”, disebut juga “jejak gambar’ atau
“bayangan”, di layar.

"Efek terbakar", "jejak gambar”, atau
"bayangan" adalah fenomena umum dalam
teknologi panel LCD. Dalam sebagian besar
kasus, “efek terbakar”, “jejak gambar”,

atau “bayangan” akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

) Peringatan

Kegagalan mengaktifkan screensaver, atau aplikasi
refresh layar secara berkala dapat menyebabkan
gejala parah "efek terbakar”, "jejak gambar”, atau
bayangan gambar" yang tidak akan menghilang
dan tidak dapat diperbaiki. Kerusakan yang

disebutkan di atas tidak tercakup dalam jaminan
Anda.

Layanan

* Penutup casing hanya dapat dibuka oleh
teknisi ahli.

* Jika harus memperbaiki atau mengintegrasi
dokumen, hubungi pusat layanan setempat.
(lihat bab "Pusat Informasi Konsumen")

* Untuk informasi pengiriman, lihat "Spesifikasi
Teknis".

* Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

€ Catatan

Hubungi teknisi servis jika monitor tidak
beroperasi secara normal atau Anda tidak yakin
dengan prosedur yang harus dilakukan bila

petunjuk pengoperasian yang diberikan telah
diikuti.



1.2 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin
disertai ikon dan dicetak dengan huruf tebal atau
miring. Teks tersebut berisi catatan, perhatian,
atau peringatan yang digunakan sebagai berikut:

& Catatan

lkon ini menunjukkan informasi penting dan
tips yang akan membantu Anda memanfaatkan
sistem komputer dengan lebih baik.

@ Perhatian

lkon ini menunjukkan informasi yang
memberitahukan Anda tentang cara menghindari
kemungkinan kerusakan perangkat keras atau
hilangnya data.

) Peringatan

lkon ini menunjukkan kemungkinan cedera
dan memberitahukan Anda tentang cara
menghindarinya.

Beberapa peringatan mungkin ditulis dalam
format lain dan mungkin tidak disertai dengan
ikon. Dalam hal ini, penulisan peringatan tertentu
diwajibkan oleh peraturan pemerintah terkait.

1.3 Pembuangan produk dan materi
kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.
Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.



Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Memasang dudukan dasar

1. Letakkan monitor menghadap ke bawah
pada permukaan yang halus dan lembut
agar layar tidak tergores atau rusak.

2. Memasang monitor

2.1 Pemasangan
2. Pasang/dorong penyangga dudukan ke

B isi kemasan monitor hingga terpasang dengan benar.

%mtkart

PHILIPS

W

Pegang dudukan dasar monitor dengan
kedua tangan dan masukkan dudukan dasar
dengan kuat ke dalam batang dudukan.

Kabel audio
(233V5QABP, 233V5QHABP)

VGA (opsional) *DVI (opsional)

* Depends on the country.

Display design may differ from that illustrated



H Menyambungkan ke PC
233V5QSBP

PHILIPS

?{ g=he
E ?H;U

© nput daya AC

© InputVGA

© nput DVI-D (tersedia untuk model tertentu)
@ Kunci antipencurian Kensington

233V5QABP

PHILIPS

AUDIO A~
IN i

© nput daya AC

© InputVGA

© Input DVI-D

@ Output earphone

© nput Audio

0O Kunci antipencurian Kensington

233V5QHABP

PHILIPS

© Input daya AC

© InputVGA

© Input HDM

@ Output earphone

© Input Audio

O Kunci antipencurian Kensington

Menyambung ke PC

1.

Sambungkan kabel daya dengan kuat ke
bagian belakang monitor.

Matikan komputer dan lepas kabel daya.

Sambungkan kabel sinyal monitor ke
konektor video di bagian belakang
komputer.

Sambungkan kabel daya komputer dan
monitor ke stopkontak di sekitar.

Hidupkan komputer dan monitor. Jika
monitor menampilkan gambar, berarti
pemasangan telah selesai.




2.2 Mengoperasikan monitor

1 Keterangan produk bagian depan

233V5QABP, 233V5QHABP
(5]
AUTO/ W -|E1 /A ;CZDZ-/ 4\ S { OK d|)
(7] 6] © 6 o (1
Menghidupkan dan mematikan
|
o © daya monitor.
Mengakses menu OSD.
@ S/0K Konfirmasikan penyesuaian OSD.
Kembali ke tingkat OSD
o < sebelumnya.
(4 O-  |Sesuaikan tingkat kecerahan.
© | A ¥V Menyesuaikan menu OSD.
Menyesuaikan volume suara
o ' speaker.
Secara otomatis menyesuaikan
© AUTO monitor.

233V5QSBP:
(5]
AU|TO/V lE|'H/A -/I(b:-/<\ @|/OK ([|)
(7] (6] ©® 6 o o
Menghidupkan dan mematikan
|
o © daya monitor.
Mengakses menu OSD.
9 /0K Konfirmasikan penyesuaian OSD.
Kembali ke tingkat OSD
o < sebelumnya.
O | & |Sesuaikan tingkat kecerahan.
© A V¥V |Menyesuaikan menu OSD.
O | [ |Ubahformat tampilan.
Secara otomatis menyesuaikan
@ AUTO monitor.




2. Memasang monitor

2. Keterangan On Screen Display

Apakah yang dimaksud dengan OSD (On-
Screen Display)?

OSD (On-Screen Display) adalah fitur yang
terdapat pada semua monitor LCD Philips.
Pengguna akhir dapat menggunakannya untuk
menyesuaikan performa layar atau memilih fungsi
monitor secara langsung melalui jendela petunjuk
di layar. Antarmuka tampilan di layar yang mudah
digunakan muncul seperti di bawah ini:

233V5QABP:

1 VGA
&= Input :
)

= VGA ’
&= Input -

233V5QHABP:

Petunjuk dasar dan mudah pada tombol kontrol

Pada OSD yang ditampilkan di atas, Anda
dapat menekan tombol ¥ A pada bezel depan
monitor untuk menggerakkan kursor, lalu tekan
tombol OK untuk mengonfirmasikan pilihan
atau perubahan.



Menu OSD

Berikut adalah tampilan keseluruhan dari
struktur On-Screen Display. Anda dapat
menggunakannya sebagai referensi bila ingin
melakukan penyesuaian lainnya nanti.

Main menu Sub menu

— VGA

— Input — DVI (available for selective models)
— HDMI (available for selective models)
— Picture Format — Wide Screen, 4:3
— Brightness — 0~100

| Picture — Contrast — 0~100
— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
— Pixel Orbiting — On, Off
— DPS — On, Off

(available for selective models)

— Over scan — On, Off

(available for selective models)

Volume — 0~100

— Alug;of Stand-Alone — On, Off

aVa|a eior Mute _ on' Off
selective models) )

Audio source — Audio in, HDMI

(available for selective models)

Color Temperature — 6500K, 9300K

— Color sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English,Espafiol,Francais,Deutsch,ltaliano,

Portugués,Pycckii, & KA 3, Tiirkge,
Nederlands, Svenska, Suomi, Polski, Cestina
St 01, BAEE, Maryar, YkpaiHcbKa,
Portugués do Brasil, EMnvik, ZH4H

— Horizontal — 0~100
— Vertical — 0~100

— OSD Settings
— Transparency — Off,1,2,3,4
“— OSD Time Out — 55, 10s, 20s, 30s, 60s
— Auto

— Setup
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L Information

El Pemberitahuan resolusi

Monitor ini dirancang untuk memberikan
performa optimal pada resolusi aslinya,

yakni 1920 x 1080 pada 60 Hz. Bila monitor
dihidupkan pada resolusi yang berbeda, layar
akan menampilkan peringatan: Gunakan 1920 x
1080 pada 60 Hz untuk hasil terbaik.

Tampilan peringatan resolusi asli dapat
dinonaktifkan dari Setup (Konfigurasi) dalam
menu OSD (Tampilan di Layar).

4 Fungsi Fisik

Kemiringan




2.3 Melepas Dudukan dan Dudukan © Catatan
Dasar Monitor ini mendukung interface dudukan yang
kompatibel dengan VESA 100mm x 100mm.
1 Melepas Dudukan Dasar

Sebelum mulai membongkar penyangga
monitor, ikuti petunjuk di bawah ini agar
terhindar dan kemungkinan kerusakan atau

cedera.
1. Letakkan monitor menghadap ke bawah _

=

pada permukaan yang halus agar layar tidak - =
tergores atau rusak. T |

PHILIPS

2. Tekan klip pengunci untuk melepas dudukan
dasar dari batang dudukan.

3. Tekan tombol pelepas untuk melepas
batang dudukan.

10



3. Pengoptimalan Gambar

3.1 SmartContrast

E} Apakah yang dimaksud dengan
SmartContrast?
Teknologi unik yang secara dinamis menganalisis
konten yang ditampilkan serta secara otomatis
mengoptimalkan rasio kontras monitor LCD
untuk kejernihan visual dan kenyamanan
tampilan maksimal dengan menambah cahaya
lampu latar agar gambar lebih jemih, tajam,
dan terang, atau mengurangi cahaya lampu
latar untuk tampilan gambar yang jelas di latar
belakang gelap.

E3 Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan
kenyamanan tampilan terbaik untuk setiap
jenis konten. SmartContrast secara dinamis
mengontrol kontras dan menyesuaikan cahaya
lampu latar agar gambar dalam permainan
serta video lebih jemnih, tajam, dan terang, atau
menampilkan teks yang jelas dan mudah dibaca
untuk pekerjaan kantor. Dengan mengurangi
pemakaian daya monitor, Anda menghemat
biaya untuk daya dan memperpanjang masa
pakal monitor.

E} Bagaimana prosedurnya?

Saat diaktifkan, SmartContrast akan menganalisis
konten yang ditampilkan secara real time

untuk menyesuaikan warna dan mengontrol
intensitas cahaya lampu latar. Fungsi ini akan
secara dinamis menyempurnakan kontras

untuk pengalaman hiburan yang luar biasa saat
menonton video atau menjalankan permainan.

3.2 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari
Phillips memungkinkan Anda mengontrol
monitor melalui antarmuka grafis layar

yang mudah digunakan. Penyesuaian rumit
sebelumnya kini tidak ada lagi karena panduan
perangkat lunak yang mudah digunakan ini
akan memandu Anda menyesuaikan resolusi
penyempurnaan, Kalibrasi warna, Pengaturan
jam/fase, Pengaturan titik putin RGB, dsb.

11

Dengan dilengkapi teknologi algoritme inti
terbaru untuk pemrosesan serta respons yang
cepat, perangkat lunak berbasis lkon animasi
yang menarik dan mendukung Windows 7/

ini siap menyempurmakan pengalaman Anda
menggunakan monitor Philips!

K} Penginstalan

PHILIPS

lkuti petunjuk dan selesaikan penginstalan.

Anda dapat mengaktifkannya setelah
penginstalan selesal.

Jika ingin mengaktifkannya di lain waktu,
Anda dapat mengklik cara pintas di desktop
atau toolbar.

www philips.com/welcome

Monitor driver and software installation
Spsterm requirements:
+ PC runing Windows 7, Vism, XP, 2000, 98,

* Go to wewphiips.com/welcome to download the latest version of monleor driver

Philips SmartControl
System twpport and requirements:
1. System support Windows 7, Vista, XP.

2 Language support English, German, Spanish, French, lualian, Russian, Portuguese. Simpified Chinese
3. Phitips Monicor Plug and Play support

Wizard pengaktifan pertama kali

Setelah penginstalan SmartControl Lite
selesai, Wizard pengaktifan pertama kali
akan terbuka secara otomatis.

Wizard ini akan memandu Anda
menyesuaikan performa monitor secara
bertahap.

Menu Plug-in juga dapat dibuka untuk
menjalankan wizard di lain waktu.

Anda dapat menyesuaikan pilihan lainnya
tanpa menggunakan wizard melalui panel
Standard (Standar).



3. Pengoptimalan Gamb

T smartContral 2 - Philips 225B1 (€530715000001) | 2)(X

SmartControl Lite PHILIPS

Wizard

You'l need to calbrate your display to get the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process involves a series of steps that wil let you
tune your display and save the settings.

1. Choose the Start Wizard button.

2. Folow the steps outlined in this process.

3. Save your settings for future use.

i

Adjust Audio

\@ Auto Piot
T
Color Tnput:
.
——eni 1
\g s
, 2
Options Presets

o

Mutti Monitors

&

Help

Start Wizard

F1 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):

* Menu Adjust (Penyesuaian) digunakan
untuk menyesuaikan Brightness (Kecerahan),
Contrast (Kontras), Focus (Fokus), Position
(Posisi), dan Resolution (Resolusi).

* Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.

» Cancel (Batal) mengkonfirmasi pengguna
Jika ingin membatalkan penginstalan.

T SmartContral 2 - Philips 22581 (CS30715000001) |7 (%

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil result in a loss of
detailin darker image arezs. Adjust the Brightness for
the best possble picture quality.
1. Lower the Brightness to the minimum level,
2. Raise the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

]

Adiust Q

Engﬁéﬂess
u Contrast
Color an

— Focus Brightness 100

= Ok
Pasition

e FF Unda Reset

Resolution

&

Help

12

W smartcontrol

SmartControl Lite

il

Adjust
Brightness
\@ Contrast
Color 2
s Focus
—
@ Position
Options FF
Resolution

&

Help

B SmartControl

SmartControl Lite

R

Adjust
Brightness
\g Contrast
Color
i Focus
— Y
@ Posttion
Options FF
Resolution

®

Help

W SmartControl

SmartControl Lite

il

Adijust
Brightness
\5 Contrast
Color
a3
Focus

= !
P on

Options ps

Resolution

LR

Help

2 - Phiips 22581 (CS30715000001) (%

PHILIPS

Contrast
Adjust the Contrast (use the sider) to keep detais in
lighter image areas.

1. Raise the Contrast until the numbers 1 and 2
are no longer visble.

2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visible.

Contrast 50
= o .

Undo Reset

2 - phiips 22581 (€s30715000001) ¥} X
PHILIPS

Focus

Your display’s timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visble, you'l need

o adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

pitch 50

= &

Phase 17

= ) +
Undo Auto Setup

2 - Philips 22581 (CS30715000001)

PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this toal, you can position the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
horzontally.
Undo Reset




3. Pengoptimalan Gamb

Menu Color (Warna):

B SmartControl

SmartControl Lite

Adiust Q)

Brightness

1

Contrast

Color @

R Focus
\g Pasition

Options g
Resolution

Help

2 - Philps 22581 (cs30715000001) (F]1%) '

PHILIPS

Resolution

You are currently at a Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.

If your display s at a Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred.

™ Enable Resolution Notifier

Picture Format
™ 4:3 aspect ratio

Prefarred

Menu Color (Warna) digunakan untuk
menyesuaikan RGB, Black Level (Tingkat
Hitam), White Point (Titik Putih), Color

Untuk item submenu berdasarkan input

Calibration (Kalibrasi Warna).
Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.
Anda, lihat tabel di bawah ini.
Misalnya Color Calibration (Kalibrasi
Warna).

1 SmartContral

SmartControl Lite

m

RGB
BHE Level

Color Wihite Point

Display Gamma

Options Calibration

2 - Phiips 22581 (C530715000001) ¥} X

PHILIPS

Black Level

Improperly adjusted Black Level wil resut in a loss of
detailin darker image areas. Adjust the Black Level for
the best possible picture guality.
1. Adjust the black level of the Red, Green, and
Blue using the sider bars.

Red 50

= J &’

Green 50

= - &

Blue 50

= - &
Undo Reset

W smartcontrol

SmartControl Lite

U )

Adjust RGB
i
Color Whle Point
— )
Display Garmma
= wy
Options Callbration
Help
" W smartControl

SmartControl Lite

)

Adjust RGB
=
Black Level
Color White Point
5,
5 =
Display Gamma
LA
Options Calbration
Help

" W SmartControl

SmartControl Lite

-

Adjust RGB
w Black Lavel
Color White Point
=
«
\Q Display Gamma

Options Glbration

Help

2 - Philps 22581 (€S30715000001) (¥}

PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intenstty create
white. This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Point.
1. Please select the White Point value for the best
passble color quality.

White Point B500K
= Q +

Undo Reset

2 - Philps 22581 (€S30715000001) |7 X,

PHILIPS

Display Gamma
Gamrma s a component of the piel brightness in a
display. A lower Gamma value produces brighter pixels

and a higher Gamma value produces darker pixels. The
defauft value for Gamma is 2.2.

To adjust Gamma, SmartImage must be set to Off.
Click the SmartImage Off button before adjusting
Gamma.

1. Use the slider to select the desired Gamma.

Display Gamima

+ &

Smartimage Off

Undo Reset

2 - philps 22581 (C530715000001) {¥1%

PHILIPS

Calibration

Your display needs to be properly calibrated in order

far it to produce the widest range of colors accurately.

Calibration should always take place as the fast tuning

step in the process. Remember to recalibrate any time

you make individual adjustments to image quality or

whenever you move your display to 2 new location.

. Make 3l other necessary adjustments to image
quality first.

. Press Show Me to learn how to use the
calibration tools.

. Finally, press Start to begin the calibration
process.

¥ Enable color calibration

Color software designed in colaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,953

Show Me Start

Quick View



3. Pengoptimalan Gambar

1.

2.

"Show Me" (Tunjukkan) memulai tutorial
kalibrasi warna.

Start (Mulai) - memulai urutan kalibrasi
warna 6 langkah.

Quick View (Tampilan Ringkas) memuat
gambar sebelum/sesudah kalibrasi.

Untuk kembali ke panel awal Color
(Warna), klik tombol Cancel (Batal).
Enable color calibration (Aktifkan kalibrasi
warna) - telah diaktifkan secara default.
Jika tidak dicentang, kalibrasi warna tidak
dapat dijalankan serta tombol start (mulai)
dan quick view (tampilan ringkas) akan
dinonaktifkan.

Info paten harus ditampilkan di layar
kalibrasi.

Layar Kalibrasi warna pertama:

Tombol Previous (Sebelumnya)
dinonaktifkan hingga layar kalibrasi warna
kedua ditampilkan.

Next (Berikutnya) menampilkan layar sesuai
urutan selanjutnya (6 target).

Layar terakhir menampilkan panel
File>Presets (File>Preset).

Cancel (Batal) menutup antarmuka
pengguna dan kembali ke halaman plug in.
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Options>Preferences (Pilihan>Preferensi) -
Hanya diaktifkan sewaktu memilih Preferences
(Preferensi) dari menu drop-down Options
(Pilihan). Di layar yang tidak didukung, namun
dilengkapi DDC/CI, hanya tab Help (Bantuan)
dan Options (Pilihan) yang tersedia.
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Preferences

Adjust Audio

ions to configure
artCon
¥ Enable men n i
’ # ¥ Enable tas anu
{ Preferences ¥ Run at systel U
| Set Transparency:
. Q & 0% © 50% C 100%
elect language:
nglist -2

\g Auto Pivot
T
Color Input
[
i
\g 8
, 2
Options Presets

\g Multi Monitors

Help

*  Menampilkan pengaturan preferensi saat ini.

* Jika kotak dicentang, fitur akan diaktifkan.
Kotak centang berfungsi sebagai pengunci.

* Enable Context Menu (Aktifkan Menu

Konteks) di desktop dicentang (Aktif)
secara default. Enable Context Menu
(Aktifkan Menu Konteks) menampilkan
pilihan Select Preset (Pilih Preset) dan
Tune Display (Sempurnakan Layar) untuk
SmartControl Lite dalam menu konteks klik
kanan di desktop. Disabled (Dinonaktifkan)
menghapus SmartControl Lite darni menu
konteks klik kanan tersebut.

* lkon Enable Task Tray (Aktifkan Baki

Tugas) dicentang (Aktif) secara default.
Enable Context Menu (Aktifkan menu
konteks) menampilkan menu baki tugas
untuk SmartControl Lite. Mengklik kanan
ikon baki tugas akan menampilkan pilihan
menu Help (Bantuan), Technical Support
(Dukungan Teknis), Check for Update
(Periksa Pembaruan), About (Tentang), dan
Exit (Keluar). Bila Enable Task Tray menu
(Aktifkan menu baki tugas) dinonaktifkan,
ikon baki tugas hanya akan menampilkan
EXIT (KELUAR).
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* Run at Startup (Jalankan Saat Pengaktifan)
dicentang (Aktif) secara default. Bila
dinonaktifkan, SmartControl Lite tidak akan
berjalan saat pengaktifan atau tidak akan
ditampilkan dalam baki tugas. Satu-satunya
cara menjalankan SmartControl Lite
adalah melalui cara pintas desktop atau file
program. Preset apapun yang ditetapkan
untuk berjalan saat pengaktifan tidak
akan dimuat bila kotak ini tidak dicentang
(Dinonaktifkan).

* Enable transparency mode (Aktifkan mode
transparansi) (Windows 7, Vista, XP). Nilai
default adalah 0% Tidak Tembus Cahaya.

Options>Input (Pilihan>Input) - Hanya
diaktifkan sewaktu memilih Input dari menu

drop-down Options (Pilihan). Di layar yang tidak

didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia. Semua tab SmartControl Lite lainnya
tidak tersedia.
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B SmartControl
SmartControl Lite

Input

Your display has two inputs {connections an back of
this disply) so you can hook up two different sources
at the same time. Use the Analog In and Digital In
buttons to select which source you'd like to view. You
| are currently viewing the analog in image.
\
IMPORTANT! If you switch inputs SmartControl may
lose the ahility to control your monitor. In this case you
may have to use the Input Select button on the front

Adijust
! ASL of your monitor to switch back to the original input
before SmartControl functionality can be restored.
\g Auto Pivot
.
Color Tnput
2 Y E
\g Wizard
, B
Options Prasets

Multi Monitors
Help

Anzlog In Digital In

* Menampilkan panel petunjuk Source
(Sumber) dan pengaturan sumber input
saat ini.

* Dilayar input tunggal, panel ini tidak akan
ditampilkan.
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Options>Audio (Pilihan>Audio) - Hanya
diaktifkan sewaktu memilih Audio dar menu
drop-down Options (Pilihan).

Di layar yang tidak didukung, namun dilengkapi
DDC/CI, hanya tab Help (Bantuan) dan Options
(Pilihan) yang tersedia.
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W smartcontrol
SmartControl Lite

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Turn off the integrated loudspeakers by checking the
Mute checkbox.

Q ™ Mute
Adjust i

Audio

i

\g Auto Pivot
-
Color Input

Wizard

=

Options Prasets

oa

Multi Monitors

®

Help

Volume 100

Undo

Help>User Manual (Bantuan>Panduan
Pengguna) - Hanya diaktifkan sewaktu memilih
User Manual (Panduan Pengguna) dari menu
drop-down Help (Bantuan). Di layar yang tidak
didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia.
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B SmartControl
SmartControl Lite

User Manual

1f you need help setting up or operating SmartContral,
ciick the Tech. Support button. You'l have the
option to fil out an Assistance Form.

You can ala choose to have information about your
software automatically attached to the assistance
form. You'll need to be online to use this feature.

i

Adjust g
User Manual

fa
®
Update
Color
=
i Display D
=
@ System 1D
Options x %
Version

&

User Manual Tech. Support



Help>Version (Bantuan>Versi) - Hanya
diaktifkan sewaktu memilih Version (Versi) dari
menu drop- down Help (Bantuan). Di layar
yang tidak didukung, namun dilengkapi DDC/C,
hanya tab Help (Bantuan) dan Options (Pilihan)
yang tersedia.

B smartControl 2 - Philps 22581 (CS30715000001) {%}X
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Version
SmartControl
/

Version 0.00 EVALUATION dtune-plp-R2009-12-17-
1913-04

1 pog/a nu
| opvight @

1993-2009 Portratt Displays, Inc.

nication: Yes - ATI2 API

Adijust ﬂ
User Manual
~
®
Update
Color
s
Display ID
" System D
Options x
o
Version

Menu Sesuai Konteks

Context Sensitive Menu (Menu Sesuai
Konteks) diaktifkan secara default. Jika Enable
Context Menu (Aktifkan Menu Konteks) telah
dicentang dalam panel Options>Preferences
(Pilihan>Preferensi), menu tersebut akan
ditampilkan.

@ SmartControl
Belect Preset 4
Tune Display

Context Menu (Menu Konteks) memiliki tiga
entri:

* SmartControl Lite - Bila dipilih, About
(Tentang) Layar akan ditampilkan.

» Select Preset (Pilih Preset) - Memberikan
urutan menu preset yang disimpan untuk
digunakan di lain waktu. Tanda centang
menunjukkan preset yang saat ini dipilih.
Preset Pabrik juga dapat dipilih dari menu
drop down.

* Tune Display (Sempurnakan Layar) -
Membuka panel kontrol SmartControl Lite.
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Menu Baki Tugas Diaktifkan

Menu baki tugas dapat ditampilkan dengan
mengklik kanan ikon SmartControl Lite dari baki
tugas. Klik kiri akan mengaktifkan aplikasi.

Help

Technical Support
Check for Update
About

Exik

Baki tugas memiliki lima entri:

* Help (Bantuan) - Mengakses file User
Manual (Panduan Pengguna): Buka file User
Manual (Panduan Pengguna) menggunakan
jendela browser default.

* Technical Support (Dukungan Teknis) -
Menampilkan halaman dukungan teknis.

»  Check for Update (Periksa Pembaruan) -
Mengarahkan pengguna ke Arahan PDI dan
memeriksa versi pengguna terhadap versi
terbaru yang tersedia.

» About (Tentang) - Menampilkan informasi
rinci tentang referensi: versi produk,
informasi edisi, dan nama produk.

* Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite,
pilih SmartControl Lite dari menu Program, lalu
klik dua kali ikon PC desktop, atau hidupkan
ulang sistem.

|
|} K
i B
SmartControl
SmartControl
‘ersion 3.20
chune-stancard-R2007-01-04-1151-23
Copryright 1983-2007 Portrait Displays, Inc.
Patents Pending
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Menu Baki Tugas Dinonaktifkan

Bila Baki Tugas dinonaktifkan dalam folder
preferensi, maka hanya pilihan EXIT (KELUAR)
yang tersedia. Untuk menghapus SmartControl
Lite secara keseluruhan dari baki tugas,
nonaktifkan Run at Startup (Jalankan Saat
Pengaktifan) dalam Options>Preferences
(Pilihan>Preferensi).

& Catatan

Semua ilustrasi pada bagian ini hanya sebagal
rujukan. Versi software SmartControl mungkin
berubah tanpa pemberitahuan. Silakan periksa
situs web resmi Portrait di www.portrait.com/
dtune/phl/enu/index untuk mengunduh versi
terbaru software SmartControl.
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4. Spesifikasi Teknis

Jenis panel LCD LCD TFT

Lampu latar LED

Ukuran panel 23" P (584 cm)

Rasio aspek 16:9

Jarak Piksel 0,265 x 0,265 mm
Kecerahan 250 cd/m?
SmartContrast 10,000,000:1

Rasio kontras (biasa) 1000:1

Waktu respons (biasa) 12ms(GtG)

Resolusi Optimum 1920 x 1080 @ 60Hz
Sudut pandang 178° (H) /178° (V) @ C/R>10
Warna layar 16,/M

Kecepatan refresh vertikal 56Hz - 76Hz
Frekuensi Horizontal 30kHz - 83kHz

sRGB YA

Konektivitas
Input sinyal

233V5QSBP, 233V5QABP: VGA(Analog), DVI(Digital, HDCP)
(tersedia untuk model tertentu)
233V5QHABP: VGA(Analog), HDMI(Digital HDCP)

Audio Masuk/Keluar

233V5QABP, 233V5QHABP: PC audio-masuk, Earphone keluar

Sinyal Input
Kenyamanan
Kenyamanan Pengguna

Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau

233V5QSBP:

AUTO/VY  [O0/A 0-/ < /0K 0)
233V5QABP, 233V5QHARBP:

AUTO/ W (/A 0-/ 4 /0K 0)

Bahasa OSD

Inggris, Jerman, Spanyol, Yunani, Prancis, ltalia, Hongaria, Belanda,
Portugis, Portugis (Brasil), Polandia, Rusia, Swedia, Finlandia, Turki,
Ceska, Ukraina, Cina Modern, Cina Tradisional, Jepang, Korea, Yunani,
Cina Tradisional

Kenyamanan lainnya

Kunci Kensington

Kompatibilitas Plug & Play

DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP, Mac OSX, Linux

Pemasangan VESA

100x100 mm

-5/+20

Kemiringan
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233V5QABP:

DEVE

Mode Aktif 26,3 W (standar), 29,61 W (maks.)

Tidur (Siaga) 0,5W

Tidak Aktif 0,5W

Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Efek terbakar, 100-240VAC, 50-60Hz
233V5QSBP:

Mode Aktif 26,23 W (standar), 26,96 W (maks.)
or 25.67 W (typ.), 26.21TW (max.) (for Analog only model)

Tidur (Siaga) 0,5W

Tidak Aktif 0,5W

Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Efek terbakar, 100-240VAC, 50-60Hz
233V5QHABP:

Daya

Mode Aktif 25,14 W (standar), 30,97 W (maks.)

Tidur (Siaga) 0,5W

Tidak Aktif 0,3W

Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

Produk dengan dudukan
(PxLxT)

547 x 416 x 219 mm

Kisaran suhu (beroperasi)

Produk tanpa dudukan

(PxLxT) 547 x 340 x 53 mm
Produk dengan dudukan 3,82kg

Produk tanpa dudukan 3,4kg

Produk dengan kemasan 5,25kg

0°C hingga 40°C

Kisaran suhu (tidak

-20°C hingga 60°C

beroperasi)

Kelembaban relatif 20% hingga 80%

MTBF 30.000 jam

ROHS YA

EPEAT Silver (www.epeat.net)
Kemasan 100% dapat didaur ulang




4. Spesifikasi Teknis

Energy Star YA
Kesesuaian dan standar
Pengesahan Peraturan CE Mark, FCC Class B, CU, SEMKO, BSMI, ETL,

1509241-307, TCO Certified, SASO, EPA, CB, PSB, KUCAS

Warna Hitam
Lapisan Luar Bertekstur
& Catatan

1. EPEAT Gold atau Silver hanya berlaku di lokasi tempat produk Philips terdaftar Untuk status
registrasi di negara Anda, kunjungi www. epeat.net.

Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran versi
terbaru, kunjungi www.philips.com/support.

N
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4.1 Mode Resolusi & Preset

E} Resolusi Maksimum
1920 x 1080 pada 60 Hz (input analog)
1920 x 1080 pada 60 Hz (input digital)

E3 Resolusi yang Disarankan
1920 x 1080 pada 60 Hz (input digital)

Frek. H. (kHz) Resolusi Frek. V. (Hz)
31.47 720 x 400 70.09
3147 640 x 480 59.94
35.00 640 x 480 66.67
37.86 640 x 480 72.81
37.50 640 x 480 75.00
37.88 800 x 600 60.32
46.88 800 x 600 75.00
48.36 1024 x 768 60.00
60.02 1024 x 768 /75.03
44.77 1280 x 720 59.86
63.89 1280 x 1024 60.02
79.98 1280 x 1024 75.03
55.94 1440 x 900 59.89
70.64 1440 x 900 74.98
65.29 1680 x 1050 59.95
67.50 1920 x 1080 60.00

& Catatan

Perlu diketahui bahwa layar Anda akan berfungsi
sempurna dengan resolusi asli 1920 x 1080
pada 60Hz. Untuk mendapatkan kualitas
tampilan sempurna, ikuti saran resolusi ini.



5. Manajemen Daya

Jika PC dilengkapi perangkat lunak yang
terinstal atau kartu tampilan yang terpasang
sesuai dengan DPM VESA, monitor secara
otomatis dapat mengurangi pemakaian daya
saat tidak digunakan. Jika terdapat input dari
keyboard, mouse, atau perangkat input lainnya
yang terdeteksi, monitor akan 'bangun’ secara

otomatis. Tabel berikut menunjukkan pemakaian
daya dan pemberian sinyal dari fitur hemat daya

otomatis ini:
233V5QABP:
Ketentuan Manajemen Daya
Mode Vid Sinkronisasi | Sinkronisasi Daya yang Warna
VESA | "'9®© | horizontal |  vertikal Digunakan LED
. 26,3 W (standar), .
Aktif [ AKTIF Ya Ya 29,61 W (maks) Putih
: TIDAK : ; Putih
Tidur AKTIF Tidak Tidak 0,5W (standar) (berkedip)
" TIDAK TIDAK
Matikan AKTIF - - 0,5W (standar) AKTIF
233V5QHABP:
Ketentuan Manajemen Daya
Mode Vid Sinkronisasi | Sinkronisasi Daya yang Warna
VESA € | horizontal |  vertikal Digunakan LED
. 25,14 W (standar), .
Aktif [ AKTIF Ya Ya 3097 W (maks.) Putih
) TIDAK ) ) Putih
Tidur AKTIE Tidak Tidak 0,5W (standar) (berkedip)
. TIDAK TIDAK
Matikan AKTIE - - 0,3W (standar) AKTIE
233V5QSBP:
Ketentuan Manajemen Daya
Mode Vid Sinkronisasi| Sinkronisasi Daya yang Warna
VESA | Y'9®° | horizontal |  vertikal Digunakan LED
. 26,23 W (standar), .
Aktif [ AKTIF Ya Ya 26,96 W (maks) Putih
: TIDAK : : Putih
Tidur AKTIF Tidak Tidak 0,5W (standar) (bedliel T
; TIDAK TIDAK
Matikan AKTIE - - 0,5W (standar) AKTIE

Berikut adalah konfigurasi yang digunakan untuk
menghitung pemakaian daya pada monitor.

e Resolusi asli: 1920 x 1080
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e Kontras: 50%
e Kecerahan: 250 nit

*  Suhu warna: 6.500k dengan pola putih
sepenuhnya

& Catatan
Informasi ini dapat berubah tanpa
pemberitahuan sebelumnya.



6. Informasi Peraturan

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

TCO Development works for
sustainable [T - manufacture,
use and recycling of IT products
reflecting environmental, social and economic
responsibility.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:
*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

* Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

e Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and ICT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)

User define mode is used for TCO Certified
compliance.




EPEAT

(Www.epeat.net)
Q The EPEAT (Electronic
W Product Environmental
Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on
51 environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

«  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

«  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

«  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

* EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

»  EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

* EN 50564:2011 (Electrical and electronic
household and office equipment —
Measurement of low power consumption)
following provisions of directives applicable

«  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

«  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

« 2011/65/EU (RoHS Directive) and is
produced by a manufacturing organization
on 1ISO9000 level

The product also comply with the following
standards

+ 1S0O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

« TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turming the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

HC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de |'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences



nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d’'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spsacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The ussr of the
device is obliged to taks all staps necessary to remove sources of intarfarence o tels-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedeno, 8 spada do do fidy A podis EN 55022,
spadd automaticky do tfidy B podie EN 55022, Pro zafizeni zatazrend do thidy A (chranné
péamo 30m) pedie EN 55022 platl nésledujicd. Dojde-ll k rufenl telekormumikatnich nabo
Fnich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rulieni odstranil.

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W eelu catkowitego wylacrenia urzadeenta 2 siect zasilania, naledy wyjat wivezks kabla
sasllaigeego 2 gmazdka, kidre powlmnno ssjdowad s w pobliag ureadeenda 1 byd 2atwo dostgpie.

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd
kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIZITE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erfillt
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgeflhrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

S EABERHS

REPEAN (RFESSREREGATENE) (BFRAPEXRROHS) -
IFRSFIH T AR S S NE SRR T ANERME B

FRBERZ
B (F&HECRT)

BEEEYRSETE
B EFR BEEENRNTE
i * i Favils ] BREE ER_EE
(Pb) (Ha) | (Cd) | (CrE+) (PER) (PBDE)
sheE o @) @) [e) [@) [e]
CRTERER X O o o o] O
BREREATE X @] o] o [o] [e]
AR A X o] @] O o] o]
ERIER# X o] @] O o] o]
RA S X [e) [e] [s] @] (o]
* ' BRI RISED RIS SRR MR R - MR R AR SRBS
O FREHEEE BN AT SR & B
{RFEATGTAEEENRARBERME) WEAERER T
X RTEAEA BN R E ORI RS R S Y
(A TFEEFRFAEAEIRNRRERGE) NENERER  BRERFIT "X B4
FEMBERHSEMER (BT E s )

@ M OR{E FHEARR

AR AR (H40), B T E R 2 AN A EAEY)
FRECOTZRAE LT (EHVZRE T A SR EINHEZER, B
TEEFmA P ERZETE R SR 2SR
EISHENHAS ~ Wrigpk E R EAR -

SPEERERITR
RIBTFEAR (BRMERIPAEENE) | ARTEUAUTER :

BERRIER (cd/W) [ > 1.05
KIFIRSHERE (W) | < 05

BEER 1%

BESUIE GB 21520-2008

e X EERERPERSUTRR : http://www.energylabel.gov.cn/

(7 s T e EUABEEZA) 2RI
Wil

P T HEAF R R R PRIPHIER > S A R AL
FrandFanf b > TEESTIE S R A F s F T T an A
BUARSREEEM - R LI B R E RN AR A
BRI P TEA R -
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.

E-Waste Declaration for India

This symbol on the product or on its packaging
indicates that this product must not be
disposed of with your other household waste.
Instead it is your responsibility to dispose of
your waste equipment by handing it over to

a designated collection point for the recycling



of waste electrical and electronic equipment .
The separate collection and recycling of your
waste equipment at the time of disposal will
help to conserve natural resources and ensure
that it is recycled in a manner that protects
human health and the environment. For more
information about where you can drop off your
waste equipment for recycling in India please
visit the below web link.

http://www.india.philips.com/about/sustainability/
recycling/index.page.

Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this
type of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
S5AAS.TA. or BSI approved type.

3. Retit the fuse cover.

If the fitted plug is not suitable for your socket
outlets, it should be cut off and an appropriate
3-pin plug fitted in its place.

If the mains plug contains a fuse, this should
have a value of 5A. If a plug without a fuse is
used, the fuse at the distribution board should
not be greater than 5A.

NOTE: The severed plug must be destroyed
to avoid a possible shock hazard
should it be inserted into a 13A socket
elsewhere.
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How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL"(“N")
BROWN -“LIVE"("L")
GREEN&YELLOW -“EARTH"("E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOWV.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected
to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain
that the cord grip is clamped over the sheath of
the lead - not simply over the three wires.




/. Layanan pelanggan dan
jaminan

7.1 Kebijakan Cacat Piksel Monitor
Panel Datar Philips

Philips berupaya memberikan produk berkualitas
tertinggi. Kami menggunakan beberapa proses
produksi tercanggih di industri dan menerapkan
kontrol kualitas yang ketat. Namun, cacat piksel
atau subpiksel pada panel LCD TFT yang
digunakan di monitor panel datar terkadang
tidak dapat dihindari. Tidak ada produsen yang
dapat menjamin semua panel akan bebas dari
cacat piksel, namun Philips menjamin bahwa
setiap monitor dengan jumlah cacat yang tidak
dapat diterima akan diperbaiki atau diganti sesuali
dengan jaminan yang berlaku. Pemberitahuan

Ini menjelaskan berbagal jenis cacat piksel dan
menentukan tingkat cacat yang dapat diterima
untuk masing-masing jenis tersebut. Untuk
memenuhi syarat dalam mendapatkan perbaikan
atau penggantian sesuai jaminan, jumlah cacat
piksel pada panel LCD TFT harus melampaui
tingkat yang dapat diterima. Misalnya, jumlah
cacat subpiksel pada monitor tidak boleh

lebih dari 0,0004%. Philips bahkan selanjutnya
menentukan standar kualitas lebih tinggi untuk
jenis atau kombinasi cacat piksel tertentu yang
lebih nyata dibandingkan dengan yang lainnya.
Kebijakan ini berlaku secara global.

4 N

Subpiksel Subpiksel Subpiksel

vy
piksel
-

)

Piksel dan Subpiksel

Piksel, atau elemen gambar; terdiri dari tiga
subpiksel dalam warna utama merah, hijau,
dan biru. Kombinasi beberapa piksel akan
membentuk gambar. Bila semua subpiksel pada
piksel menyala, kombinasi ketiga subpiksel
berwarna tersebut akan muncul sebagai satu
piksel putih. Bila semua mati, kombinasi ketiga

subpiksel berwarna akan muncul sebagai satu
piksel hitam. Kombinasi lainnya dari subpiksel
yang menyala dan mati akan muncul sebagai satu
piksel warna lain.

Jenis Cacat Piksel

Cacat piksel dan subpiksel muncul di layar dalam
berbagai bentuk. Ada dua kategori cacat piksel
dan masing-masing kategori tersebut terdiri dari
beberapa jenis cacat subpiksel.

Cacat Titik Terang

Cacat titik terang muncul sebagai piksel maupun
subpiksel yang selalu terang atau 'menyala’.
Karenanya, titik terang merupakan subpiksel yang
terlihat jelas di layar bila monitor menampilkan

pola gelap. Berikut adalah jenis cacat titik terang:

4 N

o %

Satu subpiksel merah, hijau, atau biru terang

4 N

l ¢

o %

Dua subpiksel terang yang berdekatan:
- Merah + Biru = Ungu

- Merah + Hijau = Kuning

- Hijau + Biru = Cyan (Biru Muda)

o v

Tiga subpiksel terang yang berdekatan (satu
piksel putih)

30 & Catatan



Titik terang merah atau biru harus lebih dari 50
persen lebih terang daripada titik di sekitarnya,
sedangkan titik terang hijau 30 persen lebih

saling berdekatan mungkin terlihat lebih nyata,
Philips juga menentukan toleransi untuk jarak

cacat piksel.

terang daripada titik di sekitarnya.

4 N
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Cacat Titik Gelap
Cacat titik gelap muncul sebagai piksel maupun
subpiksel yang selalu gelap atau 'mati'. Karenanya,

titik gelap merupakan subpiksel yang terlihat .
jelas di layar bila monitor menampilkan pola
- J

- %

terang. Berikut adalah jenis cacat titik gelap:

4 N

s I ~ Toleransi Cacat Piksel

Untuk memenuhi syarat dalam mendapatkan
. %

perbaikan atau penggantian karena cacat piksel
selama masa berlaku jaminan, panel LCD TFT
pada monitor panel datar Philips harus memiliki
cacat piksel maupun subpiksel melebihi toleransi
yang tercantum dalam tabel berikut ini.

Jarak Cacat Piksel
CACAT TITIK TERANG

TINGKAT YANG DAPAT DITERIMA

1 subpiksel terang 3
2 subpiksel terang yang berdekatan 1
3 subpiksel terang yang berdekatan (satu piksel putih) 0
Jarak di antara dua cacat titik terang* >15mm
Total cacat titik terang dan semua jenis 3

CACAT TITIK GELAP TINGKAT YANG DAPAT DITERIMA

1 subpiksel gelap 5 atau lebih sedikit
2 subpiksel gelap yang berdekatan 2 atau lebih sedikit
3 subpiksel gelap yang berdekatan 0

Jarak di antara dua cacat titik gelap™ >15mm

5 atau lebih sedikit

TINGKAT YANG DAPAT DITERIMA
5 atau lebih sedikit

Total cacat titik gelap dari semua jenis
TOTAL CACAT TITIK

Total cacat titik terang atau titik gelap dani semua jenis

& Catatan

1. 1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik

2. Monitor ini sesuai dengan ISO 9241-307/. (1I509241-307: Metode pengujian kesesuaian, analisis, dan
persyaratan ergonomis untuk tampilan visual elektronik)

3. 15O9241-307 adalah pengganti standar I1SO13406 yang sebelumnya dikenal, setelah ditarik oleh
International Organisation for Standardisation (ISO) sejak tanggal 13-11-2008.
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7.2 Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di
negara Anda, kunjungi situs Web www.philips.com/support. Anda juga dapat menghubungi nomor
Pusat Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Nomor hotline

Jam operasional

Austria RTS +43 0810 000206 € 0.07 Mon to Fri: 9am - épm
Belgium Ecare +32 078 250851 € 0.06 Mon to Fri: 9am - 6pm
Cyprus Alman 800 92 256 Free of charge |Mon to Fri: 9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri: 9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff | Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 € 0.09 Mon to Fri: 9am - épm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri: 9am - épm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri: 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri: 8am - 5pm
Italy Anovo ltaly +39 840 320 041 €0.08 Mon to Fri: 9am - épm
Luxembourg Ecare +352 26 84 30 00 Local call tariff |Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063  |€0.10 Mon to Fri: 9am - épm
Norway Infocare +47 2270 8250 Local call tariff |Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge |Mon to Fri: 8am - 5pm
Spain Mainteq +34 902 888 /85 €0.10 Mon to Fri: 9am - épm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri: 9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - é6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - 5pm

Informasi kontak untuk China:

Negara

Pusat informasi

Nomor layanan konsumen

China

PCCW Limited

4008 800 008

Informasi kontak untuk AMERIKA UTARA:

Negara
USA.

Pusat informasi

EPl-e-center

Nomor layanan konsumen

(877) 835-1838

Canada

EPl-e-center

(800)479-6696
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

Pusat

Negara informasi CSP Nomor layanan konsumen

+37517 217 3386
Belarus N/A IBA +37517 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

+372 6519900(General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71

+36 1 814 8080(General)
Hungary N/A Profi Service +36 1814 8565(For AOC&Philips only)
Kazakhstan N/A Classic Service l.l.c. | +7 727 3097515

+371 67460399
Latvia N/A ServiceNet LV +371 27260399

+370 37 400160(general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +37517 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225

Informasi kontak untuk kawasan AMERIKA LATIN:

Brazil

Argentina

Pusat informasi

Vermont

Nomor layanan konsumen

0800-7254101

0800 3330 856

Informasi kontak untuk kawasan APMEA:
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Nomor layanan konsumen

Jam operasional

Care Center)

Armenia
Azerbaijan Firebird
Georgia . +97 14 8837911 Sun.~Thu. 09:00 - 18:00
service centre
Kyrgyzstan
Tajikistan
AGOS
Australia NETWORK {1300 360 386 Mon.~Fri. 9:00am-5:30pm
PTY LTD
Company: Hong Kong:
Hong Kong | Smart Pixels | Tel: +852 2619 9639 Mon.~Fri. 9:00am-6:00pm
Macau Technology Macau: Sat. 9:00am-1:00pm
Ltd. Tel: (853)-0800-987
: REDINGTON | Tel: 1 800 425 6396 :
india INDIA LTD | SMS: PHILIPS to 56677 Mon.~Fri. 2:00am-5:30pm
+62-21-4080-9086
Indonesia E—EFR\(/:ICSDIITII\E/])E (Customer Hotline) Mon.~Thu. 08:30-12:00; 13:00-17:30
+62-8888-01-9086 Fri. 08:30-11:30; 13:00-17:30
PERKASA .
(Customer Hotline)
Israel Efgon'cs 1-800-567000 Sun.~Thu. 08:00-18:00
Alphascan Mon.~Fri. 9:00am-5:30pm
Korea Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. R-Logic Sdn Mon.~Fri. 8:15am-5:00pm
Malaysia I gng 603 51023336 Sat. 8:30am-12:30am
New Zealand Zt'zua' Growp | 0800 657447 Mon.~Fri. 8:30am-5:30pm
Pakistan TVQ'\“CS +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Pakistan
EA Global
Philippines Supply Chain | (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Philips
Singapore Pte :
: " Mon.~Fri. 9:00am-6:00pm
Singapore Ltd (Philips (65) 6882 3966 Sat. 9:00am-1:00pm
Consumer

Computer

South Africa | Repair 011 262 3586 Mon.~ Fri. 08:00am~05:00pm
Technologies

Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
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7.Layanan pelanggan dan jaminan

35



8. Mengatasi masalah & Tanya
jawab

8.1 Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang
dapat diatasi pengguna. Jika masalah terus
berlanjut setelah Anda mencoba solusi berikut,
hubungi staf layanan pelanggan Philips.

K Masalah Umum
Tidak Ada Gambar (LED Daya mati)

» Pastikan kabel daya telah tersambung ke
stopkontak dan ke bagian belakang monitor.

» Pastikan terlebih dulu tombol daya di bagian
depan monitor telah berada dalam posisi

OFF (TIDAK AKTIF), lalu tekan ke posisi
ON (AKTIF).

Tidak Ada Gambar (LED Daya Putih)

» Pastikan komputer telah dihidupkan.

* Pastikan kabel sinyal telah tersambung
dengan benar ke komputer.

* Pastikan pin pada kabel monitor yang
tersambung tidak tertekuk. Jika ya, perbaiki
atau ganti kabel.

*  Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

» Pastikan kabel monitor telah tersambung
dengan benar ke komputer. (Lihat juga
Panduan Ringkas).

* Periksa pin yang tertekuk pada kabel
monitor.

* Pastikan komputer telah dihidupkan.

Tombol AUTO (OTOMATIS) tidak berfungsi

* Fungsi otomatis hanya berlaku dalam mode
Analog VGA. Jika hasilnya tidak memuaskan,
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Anda dapat melakukan penyesuaian manual
melalui menu OSD.

& Catatan

Fungsi Otomatis tidak berlaku dalam mode
Digital DVI karena fungsi tersebut tidak
diperlukan.

Tanda yang tampak seperti asap atau kilatan api

* Jangan lakukan langkah-langkah apapun
untuk mengatasi masalah

* Lepaskan segera monitor dari catu daya
utama untuk keselamatan

* Hubungi segera staf layanan pelanggan Philips.
Bl Masalah Gambar

Gambar tidak berada di tengah

*  Atur posisi gambar menggunakan fungsi
“Auto” (Otomatis) dalam Kontrol Utama
OSD.

* Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya
berlaku dalam mode VGA.

Gambar bergetar di layar
Pastikan kabel sinyal telah tersambung dengan
benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

*  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Kelip horizontal muncul di layar

=

W)

* Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.



* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu

gelap

* Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan"
tetap muncul setelah daya dimatikan.

* Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama
dapat menimbulkan “efek terbakar”, disebut
juga “jejak gambar’ atau “bayangan”, di
layar. “Efek terbakar”, “jejak gambar”, atau
“bayangan” adalah fenomena umum dalam
teknologi panel monitor. Dalam sebagian
besar kasus, “efek terbakar”, “jejak gambar”,
atau “bayangan” akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

* Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.

* Aktifkan selalu aplikasi refresh layar berkala
jika Monitor akan menampilkan konten
statis yang tidak berubah.

* Gejala “efek terbakar”, “jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
Jaminan.

Gambar tampak berubah. Teks tidak jelas atau
buram.

* Aturresolusi layar PC ke mode sama seperti
resolusi asli layar yang disarankan monitor.

Titik hijau, merah, biru, hitam, dan putih muncul
di layar

» Titik tersisa adalah karakter normal yang
muncul pada liquid crystal yang digunakan
dalam teknologi saat ini. Untuk informasi
lebih rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan
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mengganggu

* Anda dapat mengatur lampu “daya hidup”
menggunakan Konfigurasi LED daya dalam
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat

Informasi Konsumen dan hubungi staf layanan

pelanggan Philips.

8.2 Tanya Jawab Umum

P1:  Sewaktu memasang monitor, apa
yang harus saya lakukan jika layar
menampilkan "Cannot display this video
mode" (Tidak dapat menampilkan mode
video ini)?

Jawab: Resolusi yang disarankan untuk monitor

ini: 1920 x 1080 pada 60Hz.

* Lepas semua kabel, lalu sambungkan PC ke
monitor yang digunakan sebelumnya.

* Dalam Windows Start Menu (Menu

Mulai Windows), pilih Settings/Control

Panel(Pengaturan/Panel Kontrol) . Dalam

Control Panel Window (Jendela Panel

Kontrol), pilih ikon Display (Tampilan).

Dalam Display Control Panel (Panel Kontrol

Tampilan), pilih tab "Settings" (Pengaturan).

Dalam tab pengaturan, dalam kotak "desktop

area" (area desktop), gerakkan panel samping

ke piksel 1920 x 1080

Buka "Advanced Properties" (Properti

Lanjutan), atur Kecepatan Refresh ke 60Hz,

lalu klik OK.

* Hidupkan ulang komputer, lalu ulangi langkah
2 dan 3 untuk memverifikasi bahwa PC telah
diatur ke 1920 x 1080 pada 60Hz.

» Matikan komputer; lepas monitor lama, lalu
sambungkan monitor Philips.

* Hidupkan monitor, lalu hidupkan PC.

P2:  Berapa kecepatan refresh yang
disarankan untuk Monitor?

Jawab: Kecepatan refresh yang disarankan
untuk Monitor adalah 60Hz. Jika
terdapat gangguan di layar, Anda
dapat mengaturnya hingga 75Hz untuk
mengetahui apakah gangguan tersebut
dapat diatasi.



P3:

Jawab:

P4:

Jawab:

P5:

Jawab:

Pé:

Jawab:

P7:

Jawab:

P8:

Apakah yang dimaksud dengan file .inf
dan .icm pada CD-ROM? Bagaimana
cara menginstal driver (.inf dan .icm)?

Ini adalah file driver untuk monitor.
Untuk menginstal driver, ikuti petunjuk
dalam panduan pengguna. Komputer
mungkin akan menanyakan driver
monitor (file .inf dan .icm) atau disk
driver saat Anda menginstal monitor
untuk pertama kalinya. Ikuti petunjuk
tentang cara memasukkan CD-ROM
pendamping yang disertakan dalam
kemasan ini. Driver monitor (file .inf dan
.icm) akan diinstal secara otomatis.

Bagaimana cara mengatur resolusi?

Kombinasi driver grafis/kartu video dan
monitor akan menentukan resolusi yang
tersedia. Anda dapat memilih resolusi
yang diinginkan dalam Panel Kontrol
Windows® dengan “Display properties”
(Properti tampilan).

Bagaimana jika saya salah melakukan
penyesuaian monitor melalui OSD?

Tekan tombol OK, lalu pilih "Reset" (Atur
Ulang) untuk menggunakan kembali
semua pengaturan pabrik awal.

Apakah layar LCD antigores?

Secara umum, sebaiknya permukaan
panel tidak mengalami guncangan yang
berlebihan dan terlindungi dari benda
tajam atau tumpul. Sewaktu menangani
monitor, pastikan tidak ada tekanan atau
kekuatan berlebihan yang diberikan pada
sisi permukaan panel. Tindakan ini dapat
mempengaruhi ketentuan jaminan.

Bagaimana seharusnya cara
membersihkan permukaan LCD?

Untuk pembersihan normal, gunakan kain
bersih dan lembut. Untuk pembersihan
secara menyeluruh, gunakan isopropil
alkohol. Jangan gunakan bahan pelarut
lainnya seperti etil alkohol, ethanol,
aseton, hexane, dll.

Apakah pengaturan warna pada
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Jawab:

monitor dapat diubah?

Ya. Anda dapat mengubah pengaturan
warna melalui kontrol OSD sesuali
prosedur berikut,

* Tekan "OK" untuk menampilkan menu OSD
(On Screen Display)

* Tekan "Down Arrow" (Panah Bawah) untuk
menggunakan pilihan "Color" (Warna), lalu
tekan "OK" untuk membuka pengaturan
warna. Berikut adalah tiga pengaturan yang
tersedia.

1.

Color Temperature (Suhu Warna);

Dua pengaturan suhu wama adalah
6500K dan 9300K. Dengan pengaturan
dalam kisaran 6500K; panel menampilkan
"hangat dengan nada warna merah-putih”,
sedangkan suhu 9300K menghasilkan
"nada dingin, biru-putih",

sRGB; Ini adalah pengaturan standar
untuk memastikan pertukaran warna
yang benar di antara berbagai perangkat
(misalnya kamera digital, monitor, printer,
pemindai, dll.)

User Define (Ditentukan Pengguna);
Pengguna dapat memilih pengaturan
warna sesual keinginannya dengan
menyesuaikan warna merah, hijau, dan
biru.

& Catatan:

Penghitungan warna lampu yang dipancarkan
oleh benda tertentu sewaktu sedang dipanaskan.
Penghitungan ini diberikan dalam persyaratan
skala absolut, (derajat Kelvin). Suhu Kelvin lebih
rendah seperti 2004K berwarna merah; suhu
lebih tinggi seperti 9300K berwarna biru. Suhu
netral adalah putih pada 6504K.

P9:

Jawab:

Apakah Monitor dapat disambungkan
ke PC manapun, workstation, atau Mac!?

Ya. Semua Monitor Philips kompatibel
sepenuhnya dengan PC, Mac, dan
workstation standar. Anda mungkin
memerlukan adapter kabel untuk
menyambungkan monitor ke sistem Mac.
Untuk informasi lebih lanjut, hubungi staf
penjualan Philips.



P10:

Jawab:

P11:

Jawab:

Apakah Monitor Philips memiliki fungsi
Plug-and-Play?

Ya. Monitor merupakan perangkat
Plug-and-Play yang kompatibel dengan
Windows 7/Windows 8/Vista/XP/NT,
Mac OSX, Linux

Apa yang dimaksud dengan Gambar
Menempel, Efek Terbakar, Jejak Gambar,
atau Bayangan pada panel LCD?

Tampilan gambar diam atau gambar
statis yang tidak berubah dalam

waktu lama dapat menimbulkan "efek
terbakar", disebut juga "jejak gambar”
atau "bayangan”, di layar. "Efek terbakar",
"lejak gambar", atau "bayangan" adalah
fenomena umum dalam teknologi panel
LCD. Dalam sebagian besar kasus, "efek
terbakar", "jejak gambar", atau "bayangan"
akan menghilang secara bertahap dalam
waktu tertentu setelah daya dimatikan.
Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan
monitor.

Aktifkan selalu aplikasi refresh layar
berkala jika Monitor akan menampilkan
konten statis yang tidak berubah.

) Peringatan

Kegagalan mengaktifkan screensaver, atau aplikasi
refresh layar secara berkala dapat menyebabkan
gejala parah "efek terbakar", "jejak gambar”, atau
bayangan gambar" yang tidak akan menghilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam jaminan

Anda.

P12:

Jawab:

P13:

Mengapa Layar tidak menampilkan teks
yang jelas, namun menampilkan karakter
bergerigi?

Monitor berfungsi paling baik pada
resolusi asli 1920 x 1080 @60Hz. Untuk
tampilan terbaik, gunakan resolusi ini.

Bagimana cara membuka kunci/

mengunci tombol pintas?

Jawab:

Tekan /0K fselama 10 detik untuk

membuka kunci/mengunci tombol pintas,
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setelah itu muncul “Perhatian” di monitor untuk
menunjukkan status buka kunci/kunci seperti
ditampilkan gambar di bawah ini.

Attention

Monitor controls locked

Attention

Monitor control unlocked
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